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FOREWORD

The Selective Reenlistment Bonus (SRB) program - with an annual budget of about $100
million - helps the Army meet reenlistment goals in approximately 200 military occupations.
The U.S. Army Research Institute for the Behavioral and Social Sciences has been conducting
original empirical research into the impact of the SRB program on reenlistment behavior.

The retention research undertaken is designed to assist the Army in the efficient
management of the SRB program. In the first phase of the study, retention parameters that
capture the financial incentive effects of the SRB reenlistment program were estimated for Army
occupations using data over the FY1990 to FY2000 period. These research results are reported
in accompanying ARI publications. In the second phase, these parameters were embedded in a
web-based SRB Management System to provide the program analyst with estimated impacts
upon retention and corresponding costs (at the Army occupation level) of alternative SRB plans.
The analysis model is ready to assist with FY2005 plans and can be updated for FY2006 (and
beyond). The SRB Management System is described in the present report.

These research results and the application analysis model have been briefed to the staffs
of the Director of Military Personnel Management, Army G-1, and Retention Management
Branch, Enlisted Personnel Management Directorate, Army Human Resources Command.

MICHELLE SAMS
Technical Director
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ARMY SELECTIVE REENLISTMENT BONUS MANAGEMENT SYSTEM:

FUNCTIONAL AND USER DOCUMENTATION

Introduction

The Army Selective Reenlistment Bonus (SRB) Management System permits analysts to
project the cost and reenlistment yield effects of proposed changes in the Army's SRB plan.1

Underlying the system is a set of econometric parameters that measure the responsiveness of
Soldiers to changes in compensation. These parameters are discussed in Hogan, Espinosa,
Mackin, and Greenston (2005) and Tsui et al. (2005).

This report provides a functional description of the system and its underlying
methodology, as well as step-by-step user guides for both components of the system - the Army
SRB Data Utility and the web-based Army SRB model.

Functional Model Description

This section provides a functional description of how the projections are implemented in the
model. The first section provides an overview of the model's structure and flow, while subsequent
sections offer more detailed descriptions of how individual portions of the model work.

Model Overview

The SRB model's projections are based on three major processes:

1. Identification and classification of Soldiers eligible to make an SRB reenlistment
decision.

2. Calculation of the impact of changes in the SRB plan and external economic
conditions.

3. Application of projected changes to estimate the number of SRB takers and the cost
of the program.

Additionally, much of the program's processing is accomplished prior to plan analysis using the
Army SRB data utility.

Data Utility Operations

The purpose of the Army SRB Data Utility is to incorporate up-to-date personnel and
bonus data using monthly data extracts. The utility also allows for preprocessing of some
calculations essential to the projection process.

Because calculation of the Annualized Cost of Leaving (ACOL) variable is relatively
time-consuming, the model precalculates all possible outcomes in the Army SRB Data Utility.

The Army SRB Program provides financial incentives for reenlistment that vary by occupational specialty, grade,

and years of service. The program is managed by the Retention Management Branch, Enlisted Personnel
Management Directorate, Human Resources Command.



The model stores a calculated ACOL value for each active skill (defined below), grade, years of
service (YOS) and SRB multiplier combination. A baseline ACOL value is also stored at the
skill, grade, and YOS level.

The data utility user can also add or delete skills from the active list for a plan year and
change award ceilings and lump-sum percentages by skill, zone, and paygrade. The user must
recalculate ACOL values any time one of these variables is changed.

The Data Utility also provides the means to import monthly data from the Total Army
Personnel Data Base (TAPDB) and reenlistment data (i.e., REUP) file extracts. The model stores
the data needed to compute eligibles and baseline reenlistment rates as well as aggregated counts
of actual eligibles and SRB takers for the month.

Identifying and Classifying Eligible Soldiers

SRB skills are defined by a combination of up to five different fields: Military
Occupational Specialty (MOS), Additional Skill Identifier (ASI), Skill Qualification Identifier
(SQI), Foreign Language (LANG), and Targeted Selective Reenlistment Bonus (TSRB)
Location. All skills are defined by a valid MOS, but may also include any combination of the
other identifiers. Soldiers' records from a monthly TAPDB extract are matched against skills in
the current plan to determine eligibility.

Prior to skill matching, each individual record is checked for some basic eligibility
requirements. First, the Soldier must have an Expiration of Term of Service (ETS) date that falls
within 12 months of the end of the plan year. Second, the Soldier's YOS must correspond to the
eligible range as defined in the model. Currently, the model allows for three SRB zones, with
YOS up to 13. However, the model has a flexible structure that will allow this range to be
redefined in the future, if necessary.

Once a Soldier record passes the basic eligibility criteria, it can be matched against the
skills in the SRB plan. In many cases, a Soldier may be eligible for more than one skill. For
example, a plan may contain both I1B Infantryman and 11B w/"P" skills. Any Soldier who
qualifies for the latter is automatically eligible for the former. In such instances the model
compares the plan multipliers for the relevant skills and assigns the Soldier to the skill for which
the SRB multiplier is the highest. Because of this logic, plan eligibles are calculated during the
projection process. This is necessary because the assignment of eligible Soldiers could change at
any time if the user changed multipliers in the plan.

At this time the model does not assign eligible Soldiers to TSRB skills. Individual Soldier
records do not contain sufficient information to allow for such assignment. The user must specify
the number of projected TSRB takers by skill, grade, and zone. Where a TSRB skill has a
"parent" non-TSRB skill (e.g., 11B Infantryman for 11B Korea), those user-supplied takers are
subtracted from the parent skill eligibles before SRB takers are projected.

SRB projection also requires computation of baseline reenlistment rates by skill,
paygrade, and YOS. The model uses similar logic to identify Soldiers eligible to reenlist in a
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previous fiscal year and then characterizes their subsequent decisions. The reenlistment rate is
simply the number of Soldiers who reenlisted (i.e., had a change in ETS of 36 months or more)
divided by the total number of eligible Soldiers. The data for this computation is drawn from the
TAPDB extract. The model does not look at SRB takers from the REUP file because it may need
to calculate a baseline rate for some skills that had no SRB during the baseline period.

Projecting SRB Takers

The Army SRB Management System incorporates econometric parameters to project the
number of SRB takers based on changes in the SRB program and changes in the civilian
economy. The model makes predictions based on changes relative to the baseline data. It
assumes that the reenlistment rates observed for the baseline period (BaseRateski, yos) were a
result of the economic conditions that occurred at that time (BaseACOLskill,Grade, yos). The
reenlistment rate in time period t is a function of the change in ACOL, /JACOLSkiulZoe (the
coefficient on ACOL), the unemployment rate (UNEMP), /3 Unemzp,Skill,Zone (the coefficient on
UNEMP), and BaseRate:

ProjectedRateSk~il,GradeYOS _ + tZS 11YOS +)6ACOLSki[l Z- (ACOLskiI.G1,,,d,,YOS -aA L I rY S 1 Z- (UNEMP, -UNEMP)1+ e- z• '° Gradyo,,•..(A O s•,,o,,,o -BaseACOL •,oOoo.s) •~ .. •,•~ V E P -U to)

whreZSI YO =In BaseRateskillryO-'''s..
where Zskllyos = Inn'1 - BaseRateskillYOS

The model parameters are assigned at the MOS level and are shown in Appendix A.
MOS-level results are available for only the largest MOSs; when MOS-level results are
unavailable, Career Management Field (CMF)-level results are used if possible. In all other
cases, the parameters are assigned from the all-Army model.

The number of projected SRB takers is simply the product of the eligible count and the
projected rate for each cell (Skill x Grade x YOS):

SRBTakersskiGrade•Yos = Eligiblesskil,1 Grade,YOS * ProjectedRateskiGradeyos.

Cost Calculation

Costs of the bonus program are based on the plan multiplier, monthly Basic Pay, the
average length of reenlistment, the lump sum percentage of the bonus, the award ceiling, and the
number of takers:

Avg.Awardskilt,YOsPaygrade = Multiplierskilt,,onePaygrade * MBPros * Avg.LORskIIros Paygrade * LumpSumPctski1,zne.

Avg.A ward SkilYOS Paygrade = max (Avg.A ward SWillrOS,~Pygrade I AwardCeiling Skillnze * LumpSumPctskillm,oe)

COSt Skill,YOS,Paygrade = Avg .A ward Skill,YOS,Paygrade *Take rs Skill,YOS ,Paygrade

3



The multiplier is read from the user's SRB plan and monthly Basic Pay is read directly from the
main database. 2 The lump sum percentage and award ceilings are also stored in the main
database for the plan year (they can only be changed within the Data Utility).

The average length of reenlistment is estimated using an econometric model described in
Tsui et al. (2005). Several variations were estimated, but the results suggest that they all have
roughly equivalent predictive power. Accordingly, the model uses the Ordinary Least Squares
regression results, because they are most easily implemented.

The main explanatory variable in the length of reenlistment equation is the present value
(in real 1995 dollars) of a 4-year Selective Reenlistment Bonus. The length of reenlistment
calculation is similar to the algorithm used to estimate reenlistment rates. The main database
contains a table with baseline observed average length of reenlistment by YOS (BASEALORyos)
from a sample of actual SRB takers. For the same takers, the table also contains average bonus
amounts calculated in the same manner they were computed for the econometric analysis
(BASEPVSRB4yos). The estimated average length of reenlistment is based on the change in the
present value of the SRB (PVSRB4yos - BASEPVSRB4yos) and the coefficient from the
econometric model.

ALORYOS = BASEALORyos + (PVSRB4yos - BASEPVSRB4ros). LORCoefficient / 12.3

Further, the model bounds ALOR to be greater than or equal to 3 years and less than or equal to
6 years.

Model Output

The Army SRB model offers three reports, which are described in the user documentation
section below. The Multiplier Levels Report (Figure 49) and Primary MOS Report (Figure 59)
show the multiplier levels by skill, zone, and paygrade. The main report, however, is the SRB
Summary Report (Figure 54). This report allows users to see the model output described in the
previous section. It summarizes the number of SRB takers by Zone and paygrade and also
reports the total cost by the same dimensions. The model actually calculates takers and cost at
the YOS level, but it is summed to the Zone level for the report display.

2 Basic Pay is stored as an annual pay by paygrade and YOS. All-Army inventory weights are used to collapse Basic

Pay to a YOS vector.
3 LOR is expressed in the econometric model in months, but must be expressed in years for the cost calculation.
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Data Utility Documentation

The Army SRB Data Utility is a stand-alone program that allows the SRB model
administrator to perform important maintenance and update functions. The administrator can
create a new fiscal (plan) year in the model, modify the skill list or change award ceilings and
lump-sum percentages, and add or delete model users and their passwords. The Data Utility also
allows the administrator to perform monthly data updates and recalculate ACOL values. There is
also a utility that allows the administrator to select an SRB plan and set it as the official plan
(thereby updating the SRB History Table).

Logging In

1. Initiate the program by clicking on the desktop icon or choosing Army SRB Data
Utility from Start/Programs menu.

2. At the login screen shown in Figure 1, enter a valid User ID and Password. The SQL
Server box should contain the string "AHRCC21SD06\PERSCOM" and the Database
box should contain "ArmySRB."

User ID:

Password:

Login .. . .. . . .......... .

User ID I

Password i

SQL Server JAHRCC21SDO0\PERSCOM

Database IArmSYSB

Figure 1. Login Screen

3. After successful login, you will see the opening screen shown in Figure 2.
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If'ie Edit Update Utlibes .. ..

Figure 2. Main Screen

Main Screen Options

The Data Utility Main Screen offers four options:

"* File - select or create a plan year.
"* Edit - make changes to the skill list, award ceilings or lump sum percentages; edit the list

of users and passwords.
"* Update - process data from monthly extracts; preprocess plan eligibles and baseline

reenlistment data; aggregate historical data; recalculate ACOL values.
"* Utilities - add or delete skills; generate tables for an SRB message; select a current SRB

plan and set it as the official plan (update the SRB History table); undo set plan.

The remaining sections of this documentation discuss each of these menu options in more detail.

File Menu

The File Menu has three options: Select Fiscal Year; Create New Fiscal Year; and Exit
(see Figure 3).

F il Edit :Update Utilities :i
I : :Seiec Fiscal Year i

Figure 3. File Menu

Select Fisrcal Year

1. Click Select Fiscal Year from the File Menu.
2. Select an existing fiscal year from the box shown in Figure 4.

6



2004 • . ..
2005

Figure 4. Select Fiscal Year

Create -Mew Fiscal Year

1. Click Create New Fiscal Year from the File Menu.
2. Enter a new fiscal year in the box shown in Figure 5.

E nter the'new kical year F K

Cancel

SII

Figure 5. Create New Fiscal Year

1. Select Exit from the File Menu to leave the Data Utility. You may also exit by
clicking on the "X" at the upper right of the main screen.

Edit Menu

The Edit Menu has four options: Skill List, Award Ceilings, Lump Sum Percentages, and
Usernames and Passwords (see Figure 6).

: M ::k!List:: : : : •

Vward Ceilings
Lump Sum Percentages

Figure 6. Edit Menu

1. Click Skill List from the Edit Menu.
2. Edit skills from the skill list editor shown in Figure 7. This screen allows the

administrator to maintain and update the list of active SRB skills associated with a
particular fiscal year. Skills must be activated for a fiscal year before they can be used
in a plan. The administrator can perform the following functions from this editor:

7



* Activate existing skills
* Deactivate skills

21B

119N,

11c.1 .1

"1184
itm12.

12C

14e

134:

13D

X3.130

13P
1 3A

X14

;4)
14S

Figure 7. Skill List Editor

Note in Figure 7 that a tree is displayed on the left side of the screen. The tree
displays all current MOSs in the database. Skills with a "+" box to their left contain
currently active skills.

3. Click on a box to expand the display and show active skills. Figure 8 shows the
expanded list for MOS 1 lB. The current list shows four active skills.
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02A
02B

02B02D

02H
02.
02K
02N
l1B

-. 11B INFANTRYMAN
'"" 11 B W/" GV"

P"l 118 W/T"
.. 11B W/'V" 75TH RANGER REGT

1 1B,11H.11M
11lB,H,M
11C
11H
11M

Figure 8. Expand Skill List

4. With the mouse over a selected MOS, right click and choose Show All Skills to
display other MOS skills that are not currently active (Figure 9). Non-active skills do
not display a check mark to the left of the title. You may also use this method to
display a list of skills for any MOS that currently has no active skills for the selected
fiscal year.
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002

02A
02B
02D
02H
02J
02K
02N

'" 11B INFANTRYMAN
... 11B W/"Gv"
... 11B W/T"
... 11B W/'V" 75TH RANGER REGT

I 11B CAMPBELL
11B DRUM
11B HOOD

. 118 KOREA
11B RILEY

. 11B STEWART

. 118 W/"G,V" HOOD
S_11B WI"J3" HOOD

. 11B W/"J3" KOREA
J 118W/"P"

. 118• W/"P" BRAGG11B,11H,11M

11 B,H,M
11C

11H
11M
Figure 9. Show All Skills

5. When you are finished activating and deactivating skills, click on the Save button.
The program will present a list box showing all of the skills that will be activated or
deactivated (Figure 10). All changes will be written to every plan associated with the
selected fiscal year. Additionally, the SRB Rules table for that fiscal year will be
updated to reflect the changes. Click Continue to accept the changes or Cancel to
close without saving the changes to the database.
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...

List Of Skills You Are Activating
118 CAMPBELL

List Of Skills You Are Deactivating
118 W"T'

Figure 10. Confirm Skill List Changes

A ward Ce&7i'/,s

1. Click Award Ceilings from the Edit Menu.
2. Award ceilings can vary by skill, paygrade and reenlistment zone as shown in Figure

11. ("SPC A" represents the E-4 Specialist at Zone A; "SGT A" represents the E-5
Sergeant at Zone A, etc; and "SSG A" represents the E-6 Staff Sergeant at Zone A,
etc.) Click on a cell in the table and type in a new amount to change an award ceiling
level.

3. Click OK to save changes when you are finished.

_______ :T SGTO I SGTC I TOA S I SSG C
11B INFANTRYMAN 110000 10000 10 100001.. .. .. .. ... ... . . .. .. . . .. . ' . ... . ... . . . .... . ... i 0 0 0 : .... ...... ... 1 0 0

110 KOREA 20000 2000 20000 20000ý 20000 20000i 200606fle
110 W,/" V" 10000! 10000 10000 10000 10000 10000 100..

118 WrJ3- 0RE.A 2000 200001 20000 20OM 2000 20000 000
le w a - • R ... ... . ...... : ........ ....o ....... .111. o ........... .. ...... -.ý PP9

118 WIN"V 75TH RANl 100 00 10000 10000: 10000 100 00S1 w w " • R t ................. ...................... .........0 00 .............000. ................. ........... ................. . q
11C IND FIRE INFMA? 10000. 100i00o100 100n00 00

11C KO R EA 0...0....... 2 0 0,_ ............ 20000 . 2............ 20000: 2.00,00 .20000 . 20000
138 KOREA 20000 20000 20000 20000 20000 20000! 2000
13B WrP" BRAGG 200007 20000 20000 20000 20000 20000. 20000
13CU130 TACS SP 20000. 20000 20000 20000 20000 20000 20000
13D FA TfCr DATA SY ........ 20000 ...... 20000' 20000 20000. 290000 2000-0. •000
13D KOREA 20000 20000 20000 20000 20000 20000 20000
13EI130 CANNON FD 20000 20000. 20000 ......... 20000 20000 20000 20600
13F FIRE SUP SP .0000 10000 10000 10000 1000 10000 1000
13F KOREA 20000 20000 20000 20000 20000: 20000f 2000

13FWP•"P" 75th RANt 100001 10000 10000 10000 10000 10000 10000
13F WPI" BRASS 10.1000 1.0000 0... -10000, 10000 1 10000: .......... 10000
13M KOREA 20000 20000 200 20 000 20 20000 20000 20000

13P KOREA 20000 20000 20000 20000 20000 20000........... 200
13R KOREA 20000 20000 2....20000 ... 00... 200 . ..... 20 0 20000
13S KOREA 20000 20000 2000o . 20000 2. 200 2. 0 ............ ý2000
13 KOREA 20000 20000 20000 20000 20000 20000: 200.0
1 W WrFP RRARI 2000n 2nnnn0 2nnn0 20nnnn 2000 n0n0nn 211n0n

Figure 11. Edit Award Ceilings

Lump Sum Percentages

1. Click Lump Sum Percentages from the Edit Menu.
2. Lump Sum Percentages can vary by skill, paygrade and reenlistment zone as shown

in Figure 12. Click on a cell in the table and type in a new amount to change an award

11



ceiling level. Percentages should be entered in decimal format (e.g., 1.0 to signify
"100%").

_ _ -__ SPCA SGT A SOT B SGT C SSG A SSG B SSG C
11B INFANTRYMAN 1.00 1.0M 1.00 1.00 1.00 1.00 1.0
110 KOREA 0 -. 50 0 .50 .050 .. 0. 50.......... ........... 50 0.50
118 wroGV'1 .01, 1.00 1.00 1.00 1.50..1.00 1.00
1i1B WrJ3 KOREA 0.50. 0.50. 0.50 0.50 0.50 0.50 0.50.
110 W/-V 75TH RAN i.00 1 1. . 1 1
JiC IND FIRE INFMAP 1.ff 1.0 1.00 100 15. 1.00. 1.00

JiC KOREA 0.50 0.50 0.50 0.50 0.50' 0.0 050
138 KOREA 0.501 0.50 050 050 ...... 05. 0ý.50. . 050
13B W/"P" BRAGG 0.50 050 0.50 050 0.50. 050 050i 3 C /1 D T A P S P • ' ..................... ...... .........ii .................. -1 0 ....... .......... 01 0 .. ............ i' ..................i S i .................... ii
13CI13D TACS SP 0.50 050 0.50 0.50: 0.50. .5 . 0"130 ~ ~ ~ ~ ~ ~ ~ ~ ~ ~ ~ ~~~~1 FA T T D T ......... i~ ....... .... i~• . .................. i5 ......... . .- 1.1 -I I"50 .................. ASO'• ........... 0:5i ........... i
130 FA TCT DATA SY 0.50 050O 0.50 0.50 0.50..05'.%
13D KOREA 050 0.50 0.50 0.50 0.50' 0.... .
13EI13D CANNON FO 050 0R50 0A50 050 05..O0.501. 0.
13F FIRE SUP SP 1.00; 1.500 1.00 1.00, 1.50 1.001 .5
13F KOREA 0.50 0.5 0.50 0.50 0.50' (550 0.50
13F WPP" 75th RAN. 1.00 1.50 1.00 too1 1.50. 1.o00 1.50

i• KO E • ........... 0 N~ ........... • • !....... ............. .... . 2 0 ............. • .. .............. -i ....................Bi13FWI"P" BRAGG 1.00, 1500 1.00 1.00 1.500 .1.00 1.5W
i 1 3 R K R E A • -- ................ 02• i ............. ... i .. ....... .. .... i O..... . . ........ . .• .. ... .. -........... b • ......... ... 50 ............... 213M KOREA 050 050 0.50 0.50 050... .50ý 0.5

13P KOREA .50 0.50 0.50 0.50 .0.50 .050:. 0.50

.... .. . ... ... . -- o1 .1......... ......... ... ..... ..... 0 513R KOREA 050 0.50 0.50 0.50 0.50 0.501 0.50
13S KOREA 050 0.50: 0.50 0.50 050 0.50 0.50
13W KOREA .05 050 00.5 50 0.50 0500
lIWWr~Ii RAr.G nrin n 9:n 05n n0 m 5 n 0 00n0. n 9

Figure 12. Edit Lump Sum Percentages

Usern ames andPasswords

1. 'Click Usernames and Passwords from the Edit Menu.
2. Select an existing user by clicking Edit or add a user by selecting Add New (Figure

13). You can specify the usemame, password, user type and CMF access level of
each user.

Usr sernamne Password CMF Ei
Sheryl.Carroll Sheryl ALL d

Analyst Ken Obrien 18
Analyst Warren.Dodd Warren ALL

.. :

Figure 13. Edit Usernames and Passwords

3. Figure 14 illustrates the process of adding a new user, although the process for editing
an existing user is analogous. Select a user type (Analyst or Division), enter a
Usemame and Password and select a CMF. Division users cannot edit plans; they can
only view reports. Selecting a CMF other than All will restrict the user to see data or
plans only for skills in the selected CMF. Click Save to add the user.

12



UserTyp Usernamre Password JCMF
Analyst Sheryl.Cerroll Sheryl ALL
An alyst Ken Obrien 18
Analyst Warren.Dodd Warren ALL

User Type Username Passwotd CMF .. l .

[ iso 7 ,,PaMackin ]PatCanc

Figure 14. Add New User

4. Click Close when you are finished editing users.

Update Menu

The Update Menu allows the administrator to process monthly data extracts, create
preprocessed tables that are used in the SRB plan projections and recalculate ACOL values,
which are also used in projections. The four Update options are shown in Figure 15.

.. . r .........

File Edit Update Utilities

Recal:.. te ACOL Vales
Monthly Update

planning Update k

Aistoric SSN level Eligibles

Figure 15. Update Menu

Recalculate A COL Values

You will need to recalculate ACOL values whenever any of the following conditions are
true:

"* You added or activated skills for the fiscal year
"* You changed award ceilings or lump sum percentages
"* You updated pay tables or economic indexes

The recalculation process updates an ACOL value table for the selected fiscal year. This table is
dimensioned by skill, grade, and YOS.

1. Select Recalculate ACOL Values from the Update Menu.
2. Select a monthly time period from the list provided (Figure 16). The time period is

used to select an all-Army inventory that the ACOL calculation needs in order to
collapse some pay tables.

13



Select date from below:
: Ih r, = i " IIIIIII -
S11/30/2004

12/31/2004
01/31/2005
02/28/2005
03/31/2005
04/30/2005
05/31/2005 ..

Figure 16. Select Monthly Time Period for ACOL Calculation

3. Select a base year for the ACOL calculation (Figure 17). The model calculates a
baseline ACOL value for every skill and YOS. You must also select a monthly time
period from the base year for the calculation.

[2003 - [;

2005 I

Figure 17. Select Base Year for ACOL Calculation

4. Next, select a Base Plan (Figure 18). The Base Plan should contain the multiplier
levels that most accurately represent the levels that were available to Soldiers during
the base year. Because the Army may have, in fact, experienced several changes in
the plan over the course of the fiscal year, the Base Plan should be constructed as a
composite.

I.1

NewPlan w
SherylNew~lan . . . .

Figure 18. Select Base Plan for ACOL Calculation

After you select a Base Plan, the model will recalculate ACOL values for the fiscal
year. This process may take 3-5 minutes to complete. The model notifies you upon
completion as shown in Figure 19.

i:4 .... .Recalculation of ACOL values completed sccessfully.

Figure 19. ACOL Recalculation Completion Message
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AMonthly updaze

The monthly update keeps track of the counts of individuals by skill that were eligible to
reenlist by skill. The model looks forward for eligibles (e.g., the 30 September 2004 monthly
update determines which Soldiers will be SRB eligible during October 2004). The eligibility
criteria are based on the current official plan.

The monthly update also pulls information from the REUP extract on individuals who
received an SRB in the previous month. Counts of SRB takers and costs are stored at the MOS
(rather than skill) level.

1. Select Monthly Update from the Update Menu.
2. Select a monthly time period that corresponds to the data extract (see Figure 16).
3. Browse to the text file to be used for the update (Figure 20).

Look in: L- Aiwy SRS Phase 11 ~)~i
2-ACOL Code
' •..i Data Ana 'yss

I Data Dictiona.ies
ZDDFAS Data

•Progress Reports

•Spreadsheet Model

:DSRB Nessages

LUser Documentation
,Validation

0 Query 2
(•J- Query 2

F1S of bpe: . TextRleo. txt ' Cncel

F Open as nead-onl:

Figure 20. Monthly Update Browse Window

Planning [p date

The Planning Update function allows the administrator to preprocess a table of SRB
eligibles for the fiscal year and a table of eligibles for the base year. Both sets of data are stored
at the individual level so that they can be sorted and aggregated by skill during the plan
projection.

1. Select Planning Update from the Update Menu.
2. Browse to the data extract to be used in the update.
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His'toricX: SSIVZ evl El'ligihes

The Historic SSN Level Eligibles function generates an extract that can be used for
model validation. For example, it could be run on end-2004 data to generate a table of SRB
takers and eligibles that will allow an analyst to compare the model's predicted outcomes with
observed outcomes.

1. Select Historic SSN Level Eligibles from the Update Menu.
2. Input a fiscal year for the analysis (e.g., 2004). See Figure 21.

Please Input A Ri ca Year: OK

Figure 21. Update Historic SSN Eligibles Fiscal Year

3. Browse to the data extract to be used in the update.

Utilities Menu

The Utilities Menu allows the administrator to perform five functions:

* Create new skills.
* Delete existing skills. An existing skill can only be deleted if it does not yet occur in

the SRB History table. If it is in the history table, the skill may only be deactivated.
* Generate SRB message tables.
* Designate a plan as the official plan for all or a portion of the fiscal year.
* Undo the last official plan designation.

File Edit' Update Fu Utiities
I~ ~ ~ ~Cet Nev,,,"I III. •I, skill

SGenerate Message
SSet AsOffical Plan :

J:ndo Last Official Plan;:::

Figure 22. Utilities Menu Options
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Create New Sk.ills

Click on the Create New Skills option from the Utilities menu to add a skill that does
not yet exist in the database. The Add New Skill Edit screen is displayed as shown in
Figure 23.

MOS MOS Add
11B INFANTRYMAN
11C IND FIRE INFMAN Reset

ASI 11H HVYAAWPNS INF
F -llM FV INFANTRYMAN

1× INFANTRY . ,I
SQI I"Z INFANTRY SEN SGT

12B COMBAT ENGINEER CreateNew
12C BRIDGE CRWMEM

Language 12F
S -1"/ COMBAT ENGR SEN SGT Close

13B CANNON CRWMEM
TSRB 13C TACSSP
I" ". . 13D FA TCT DATA SYS SP

MOS/TITLE:

Figure 23. Add New Skill

2. All skills must include a valid MOS. Select an MOS from the MOS list by left
clicking it to select it and dragging it into the highlighted MOS input box on the left.
Click on the Create New button if the MOS does not already appear. Enter the
requested information as shown in Figure 24.

MOS mC'F: 100 - - -I

Description

Figure 24. Add New MOS

3. In addition to a valid MOS, you may optionally define a skill by ASI, SQI, Language
and TSRB location. Choose any of these by clicking on the appropriate input box to
display a list of valid codes to the right and drag your selection to the input box. You
may also add a new code in the same manner that they are added to the MOS list.
You may select multiple ASI, SQI, and Language codes for a given skill. By default,
multiple selections are joined with a logical "OR," which means that the Soldier
qualifies if he or she has either code. Alternatively, you may click on the displayed
And button to the right of the code; Soldiers would then have to have both (all) codes
to qualify. TSRB locations are unique; only one may be selected per skill.

Figure 25 illustrates this process. For the new skill, the MOS 1 1B was selected. Next,
two SQI codes were added. As displayed, an 11B Soldier who carried either the "G"
or "P" SQI on his record would be eligible for an SRB under this skill. Note that the
utility builds an MOS title as I1B W/"G,P".
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Mos SQl Add
Il ls F Flying Status

G Ranger ResetASI H Instructor

I 5Ql S ~Special Forces/ Special OpsRe tAl
AdV Ranger

Language

KTSRB

MOSITITLE:jI B W/"G,P" :

Figure 25. Adding Multiple SQIs to Skill

Click on the And button to the right of the SQI input box and the condition is changed
(Figure 26). Note that the MOS title is now I1B W/"G&P" and the And button has
been replaced by an Or button that would allow you to toggle back to the original
condition.

MOS SQl Add
ri1BF Flying Status
A516 RangerRetAi H Instructor

• . Special Forces Special 0ps . s" Ail

SQl V Ranger

JG&P~ , 0r1 CfaeNewj

TSRB

MOS/TITLE:

11 filvV/"G&P'

Figure 26. Change SQI Condition

4. If you have mistakenly added a skill condition, click on the appropriate input box on
the left and then click the Reset button to clear the box. The Reset All button will clear
all input boxes on the left (including the MOS) and allow you to start over.

5. When you are finished defining the skill, click the Add button. If the skill already
exists in the database you will be notified. Note that the new skill will not appear in
any plans until you have activated it from the Edit/Skill List function (Figure 27).
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COBE *2005
008

02A

02B

02D

02H

021

02K

02N

118
i. ._j. 11B INFANTRYMAN

&/I 11B KOREA

.- J 118 W/'G,V"

.. 11B W/"J3" KOREA

v. 118B W/'V" 75TH RANGER REGT

. 11B CAMPBELL
J 11B DRUM

11B HOOD

11B RILEY

11B STEWART
11B W/"GV"HOOD

j 118 W.'J3" HOOD
11 B W/P"

, 118 WPP" BRAGG

11B,11H,11M
11B,H,M

r- 11C
11H

11M

Figure 27. Updated Skill List

Delele Skills

If you have added a skill mistakenly but have not yet used it in an official plan (i.e., it
does not yet exist in the SRB History table), you may delete the skill by choosing the
Delete Skills option from the Utilities menu. Select a skill from the list shown in
Figure 28 by clicking on the skill's MOS. Click the Delete button to remove the skill.

MOS AS[ SQI Lang. TSRB MOS!TITLE I A
02D 00 0 00 0 02D FRENCH HORN PLAYER

02H 00 0 00 0 02H OBOE PLAYER
02J 00 0 00 0 02J CLARINET PLAYER
02K 00 0 00 0 02K BASSOON PLAYER
02N 00 0 00 0 02N KEYBOARD PLAYER
11B 00 0 00 0 118 INFANTRYMAN
11B 00 0 00 CAMPBELL 118 CAMPBELL
11B 00 0 00 RILEY 11B RILEY
11B 00 0 00 STEWART 11B STEWART
118 00 0 00 DRUM 11B DRUM
11B 00 0 00 HOOD 11B HOOD
11B 00 0 00 KOREA 11B KOREA
11B J3 0 00 KOREA 119 W/"J3" KOREA
11B J3 0 00 HOOD 11B W/"J3" HOOD
118 00 GV 00 0 11B W/"GV"
11B 00 P 00 0 11B W/"P"
118 00 G&P 00 0 11 8 WiG&P"

11B 00 V 00 75th RANGER REGT 11B W/V' 75TH RANGER REGT
11B 00 P 00 BRAGG 11 B W/"P" BRAGG 3-
11D no. . . . . inn unnr I I D %.I1, - %" 0 unnrn

Figure 28. Delete a Skill
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2. After you delete the skill, you will be asked to confirm your action (Figure 29). Click
No if you have changed your mind or Yes to confirm the deletion.

ASI 00sql: G&P
Languag•e: O0

"TSRB: 0

VAR be de'-ted. Ar• you sure ?

Figure 29. Confirm Skill Deletion

If the skill already exists in the history table you will not be able to delete it and will
see the error message displayed in Figure 30.

You can not deate:

ASI 00
SQl
" Languge - 00

:T S.B - 0

M OS/ I-.E - 11B I'ANTRYM AN
It % aieady part of the history fe.

Figure 30. Skill Deletion Error Message

3. Click the Close button when you are finished deleting skills.

Generate Afessage

1. Select Generate Message from the Utilities Menu.
2. You will see a list of plans associated with the selected fiscal year as shown in Figure

31. Click on the plan you want and Click Select Plan.

I VT . 1 M ?1 .... ........... .......... .-. . . . .. ...... .. ... . . ...... .......... •... . • ;i • i; i ,:•

Planb5b04 
SectPa

Figure 31. Select Plan to Generate Message Tables
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3. Type in a Message Title. This title establishes the naming convention for the Access
tables created for the new SRB message (see Figure 32).

Please type name for this message.

INew SRB Message 12115/2-.2l 4

Figure 32. Message Title for Official Plan

4. Browse to an Access database where you would like the SRB message tables stored.
The utility will create four tables: Increases, Decreases, Increase/Decrease (i.e., skills
with both an increase and a decrease), and the In Effect table (i.e., the current plan.
You can export these tables easily to a Word document in order to generate a new
message.

Set As Of/•'fia/Plan

1. Select Set As Official Plan from the Utilities Menu.
2. Select a plan from the list on the screen shown in Figure 33. The plan that is currently

official is denoted as such.
3. After selecting a plan, enter the date on which SRB increases become effective and

the date on which decreases become effective (generally 30 days later).
4. Click the Set As Official button.

Plan Name Status . Ol fical
Plan04163 Official

SherylNewPlan

Month Day Year
MultiplierlncreaseDate: j12 [15 12004

Mul•iplier DecreaseDate: F1 j14 F2005

Figure 33. Select Official Plan

5. Verify that you want to set a new official plan (see Figure 34). Changes to the SRB
History table will take several minutes.
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StigNewPlan as offcal plan.
Are you sure?

Figure 34. Verify Change in Official Plan

6. When you are finished changing the Official Plan, close the Select Official Plan

screen (Figure 33).

Undo Zasl Offz;viil•P/n

You may also undo the last set official plan action using the Utilities menu. This will
remove the last changes to the SRB History table and reset the official plan as it was prior to the
last change.

1. Select Undo Last Official Plan from the Utilities Menu.
2. Verify that you want to undo the last official plan change (Figure 35).

'Ths action will oveday the SPBH-istory table with data from the previous offidal Plai.\Q Continue?

Figure 35. Undo Last Official Plan Change

3. When the undo is complete you will see the verification message displayed in Figure
36.

~QSRB Hi stor y undo comrpleted successfully

Figure 36. Undo Official Plan Verification Message
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Army SRB Model User Documentation

The Army SRB Model is a web-based projection tool that allows analysts to create
alternative SRB plans and predict their effects on reenlistment yields and SRB plan costs.
Projections are based on a set of econometric retention models that are discussed in detail in the
technical documentation.

Logging In

1. Start the model by clicking on the desktop icon for the Army SRB Model.
Alternatively, you can browse to the main page's location on your server using
Internet Explorer.

Main Page url:

2. At the login screen shown in Figure 37, enter a valid Username and Password. Both
are case-sensitive. Click the Login button.

Username:

Password:

S. . . . . . . .. .. . . . . . . . . . ....... .. . . . . . . .

PCPsword:

Figure 37. Login Screen

3. After successful login, you will see the main page shown in Figure 38.
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BArK SRBh Model

Fiscal Year.

12o04 1 1
Plan Name Report Name

View Reports FPlan4163 IM ILultipIier LeMe

Plan 'Name:

Edit Plan iTe~st2004

Create A New Plan

Figure 38. Main Page

Main Page Options

The main page of the model offers the following options:

* Fiscal Year - choose a plan year to examine.
* View Reports - choose an existing plan and see projected SRB output and cost plus

multiplier levels.
"• Edit Plan - select an existing SRB plan and make changes to the multiplier levels or

number of TSRB takers.
"* Create a New Plan - make a copy of an existing plan to which additional changes can be

made.

The remaining sections of this documentation discuss each of these menu options in more detail.

Fiscal Year

The Fiscal Year option allows the analyst to choose one of the fiscal years in the
database. New years can only be added to the database using the Army SRB Data Utility.

1. Select a fiscal year from the dropdown box as shown in Figure 39. The main page
will then display only the plans available for that fiscal year.
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Arno' 1 R4 Mde

Fiscal Year.

12004
2003 Plan Name Repoat Name

JPIanO4163 FmI o j~lileLeels

Plan Narne:

Edit Plan jTaat2OG4

Create A Nec• Plar

Figure 39. Selecting Fiscal Year

Create a New Plan

You can create new plans by making a copy of an existing plan. When a new planning
year is created in the Data Utility, a default plan is created that is based on the current official
SRB plan, so there will always be a plan available as a starting point.

1. Click on Create a New Plan on the main page.
2. A dropdown box and an edit box will be displayed as shown in Figure 40. Select the

plan from which you would like to copy from the dropdown (upper) box.
3. Type in the name of the new plan. You can use a descriptive name so that you can

remember why you created the plan, but the name must contain only alphanumeric
characters (no spaces or special characters).
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• d•" I,• • • 'io~r•'•i•'• r• ,'/ • : •:-" . . .... . .... ......... .............. .. ....... ....

.4rnqrSRB •fodel

Fiscal Year:

Plan Name Report Name

Pla NaNae:

Create A New Plan Plan To Cop:, [PlanO4163

New Pla: I

OK Cancel

Figure 40. Create a New Plan

4. Figure 41 illustrates this process. The user has just created a new plan called
ExampleTest. It is a copy of the existing plan Test2004.

5. Click OK to create the new plan.

Arny SRB 211,odel

Fiscal Year.

Plan N-ame Report Name

Plan .Name:

E dit Pln

Create A New Plan Plan To Cop:.r ITest2004

New Plan! IExampleTesti

OK Cancel

Figure 41. Entering New Plan Name

26



Edit Plan

Edit Plan has two functions. You can edit SRB multiplier levels at the skill, grade and
zone level, and you can input the projected number of TSRB takers at the skill, grade, and zone
level.

1. Select an existing SRB plan from the dropdown box to the right of the Edit Plan link
on the main page (see Figure 42).

Arno, SRB Jf1odel

Fiscal Year.

Plan Nane Report Name

iew Report, [%PoanO41r3 Muhtiplier Levels

Plan Name:
Edf Plan .IM

Create A New Plan

Figure 42. Select SRB Plan to Edit

2. Click on the Edit Plan link.
3. The model displays the main Edit Plan page as shown in Figure 43. Up to twelve

skills are displayed at one time. Use the Next link to move through the plan.

The Edit page shows every skill that is activated for the current fiscal year. Some
skills may have no non-zero multipliers, but have been added for planning purposes.
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E•- t . et e Fgvotes lods &1p

Backs .aro avrbe

... • .- ....... .i ... ......:; .. .>- o .......• - ......................... .,• ................ : : ... .: ...I: ._ IL .. . .{ I......

IB NF A•TRYI.%A- 1.0 1. 0 00 .0 10 00 Edlt

13B KOREA 2.0 2.0 2.0 0.0 2.0 1.0 0 Edit

113 WON" 1.5 1.5 IA5 0.0 1.5 1.5 •0.0 E,

l013W ,J" KORA 0., 2.2 2.5 0.0 2.5 V Ed0

4iB W"V" 75TH RNLGER REGT 2., 2.0 1.5 0.0 5.0 0.5 0 t

cI,1F.E t 3l,." 0.0 1.0 LO 0 . 0.0 Edit1

1C KOREA 1.5 1. 0.5 0.0 1.f 1.5 _.0 Edit]

13B KOEA 1.0 0.0 .5 0.0 L50 0.5 0.0 E

13B W"11" BRAGG 0.0 0.0 0.5 0.0 0.0 0.0 . O Edit

ISC'ISDTAC3SP0 0.5 0.5 0.0 0.0 0. 0.0 0.10 Edjit

13D FA TCT DATA SYS SP 0.5 0.1 0.0 0.0 0. .• V. "O Ed
13D KOREA 1.0 1.0 0.5 0.0 1.0 0.5 0.6 Edit

preýoio,. Nent 1 of 23 Home Avaable MOS's F ".EITSRB'"I

Figure 43. Edit Plan Main Page

4. Individual skills' SRB award levels (or multipliers4) are changed by clicking on the
Edit button to the right of the skill. The multipliers for the selected skill appear at the
bottom of the page in a set of edit boxes as shown in Figure 44. Note that the original
display area is now grayed out. Change multiplier levels by clicking in the
appropriate box and typing the new level. Click OK when you are finished editing.
The original display (Figure 43) will return, with the changed multipliers shown.

4 The retention bonus for the particular skill and zone is the product of the multiplier, monthly basic pay, and length
of reenlistment (in years).
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00E3hTANMNYA-N 1.0 1.0 L0 0.0 1.0 .0 0.0

I0 is OREA 2.0 N. 2.0 0.0 2.0 1.0 -0.0 j
11B II',VIL, ý 1 0. 1ý 11.5 C0.0

10 75KRA0.0 2.5 V. 0.0 2.5 2.5 0,0 c

IB %w X"520AN-ClERRET 2.0 2.0 0.5 0.0 2.0 1.5 0.00

pcL\CFL LFffLE0TAŽV 1.0 1.0 1.0 .0.0" 1.0 1.0 u.

bCK RA1., 1.5 0.5 0. .0. 1.! 0.0

05B XORVA 1. . ..0 0 .0 0. 0.0

013B W"P? BOAQio 0.0 0.0 M. 0.M . 00 00 C

3~ ~~ C I IASS 4 0- , '

I1DF.,TCTDAIASYSO 0.5 0.5 0. .0 05 0. .0 E4

I--D KOREOA 1U 0.0 0.3 0.0 0.0 0. n.

0511305 TACS SP F F j _F7o~ VT. .jO. 00 .____

k1e>.3t Nexts I of 2 Hi. Aaiable MOS's IGOosB dtTR'

Figure 44. Change Skill Multipliers

5. To edit TSRB takers select an MOS from the dropdown box at the lower right corner
of the page. In Figure 45, we have selected 13F.

000CAN3OlP0. 03 0.0 0.0 0ý5 00 00 FE.

10F010.WOSUP P 1.0 0 0.0 L, 0 00 d

1101 OZEA 00 2..G 0 20 00 EdD

13F W--" P' t BPAOE I RO 0.0 1.5 1.3. 0.0 .' ' Edit

03K OA0.0 I' 0 0 05 0.0 0.0 0.5 0.0 Edit

3P KOOO M.0 0D1.0 0.5 0.0, I.0 0.5 0. EdIt

13 RKOROBA C.0 0.0 0. 0.0 0.0 0.5 0.C EdtD

130 KOREA 0.r 0.0 0.5 0.0 0. 0. 0. Ed.,

13WX000.A L.0 0. 0.5 0.0 L.2 0. 0. dio j
IOW0'BAO00 1.0 0.0 0.0 C. 0. 0.0 Edt

14E KOZA. 0La 0.0 0. 0.0 0.0 0. 0.0 Edit

Pre-,iou 'Next 2 of 23 Horne Avaiable IOS's 100~ edit TS46s

13B0

13D
13E

13N1

Figure 45. Select MOS for TSRB Editing
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6. After selecting an MOS, click the Edit TSRBs button. You will see the page displayed
in Figure 46. Two tables are displayed. The top table shows the number of projected
eligible Soldiers by skill, grade and zone for any non-TSRB (SRB) skills in the MOS.
This table is for display only and cannot be edited by the user. The bottom window
shows the number of takers by skill, grade, and zone for the TSRB skills in the MOS.

,k Edti Fn yonto tno op

----- - -;~~,a3 < q~ -
.... ........ ' t • ,, +L ... ......... ... ....... ............. ........... ..... ............................. . ...... : _
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Figure 46. Edit TSRB Takers Page

7. Each skill may be edited in the same way that multiplier levels are edited on the main
Edit Plan page. Click the edit button to the right of the relevant skill. Figure 47 gives
an example. We have selected the skill 13F Korea. We have entered projected takers
for SPC Zone A, SGT Zones A and B, and SSG Zone C. When the Summary Report
projections are run, these takers will be subtracted from the eligible pool for 13F
FIRE SUP SP before projecting SRB takers.

8. Click OK when you are finished editing a skill.
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Figure 47. Changing TSRB Takers

9. When you are finished editing the TSRB takers for the selected MOS, click the SRB
Plan link to return to the main editing page. You must return to the main editing page
to select another MOS for TSRB editing as well.

10. From the main editing page (Figure 43), click on the Home link when you are
finished editing multipliers and TSRB takers.

View Reports

View Reports allows the analyst to view the plan multipliers; a summary report that lists
multipliers, projected reenlistments and projected costs; or a multiplier report for skills defined
only by the MOS. Each report is easily exported to a Microsoft Excel workbook for further
offline analysis and comparison with other scenarios.

AIul/ /lie r Levels Repoor t

1. Select an SRB Plan from the Plan Name dropdown box to the right of the View
Reports link. Choose the Multiplier Levels report from the Report Name Dropdown
box (see Figure 48).
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Figure 48. Select Multiplier Levels Report

2. Once you have selected a plan and a report, click on the View Reports link.
3. The Multiplier Levels report (Figure 49) displays the SRB multipliers by skill,

paygrade and zone for the selected plan. Use the scroll bar on the right side of the
display grid or use the PageUp and PageDown keys to see additional rows of the
report.
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Figure 49. Multiplier Levels Report

4. You can export the multiplier level report to a Microsoft Excel workbook by clicking
the Export to Excel button at the top of the page. The Dialog Box displayed in Figure
50 shows that the workbook is automatically named using the convention
Mult&Planname.XLS (e.g., MultExarnpleTest.XLS). You may either open the
workbook directly or save the workbook to a local or remote (network drive).
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Do you war-A to open or save tbis file?

Name: MultExampleTestXLS

z Type: Microsoft Excel Worksheet

From: PERSCOM

SWhile files from the Internet can be usefull, some files can potentially
harm your computer. If you do not trust the source, do not open or
save this file. What's the nisk

Figure 50. Export Multiplier Levels Report to Excel

5. When you save the workbook, you may also choose a different name by overwriting
the default name in the File Name box (see Figure 51).

Savein: JLý,mySRB Model Repots ' "

Fienae P~LAExampleTes! av

Save as ype: jMhcrooft ExWcel Worksheet Cancel

Figure 51. Multiplier Level Report Export Save to Disk

6. Once open in Excel, the Multiplier Levels report can be customized or compared to
the Multiplier Levels report from another plan (see Figure 52).
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Figure 52. Multiplier Levels Workbook

7. Click the Home link to return to the main page.

SR, Summary Report

1 . Select an SRB Plan from the Plan Name dropdown box to the right of the View
Reports link. Choose the SRB Summary report from the Report Name Dropdown box
(see Figure 53).

Arqy SRB BIodel

Fiscal Year

Plan Nmne Report Name

ViewExamplTest ... zJ

Plan Name:

Edit Plan Txst20oo

Create A New Plan

Figure 53. Select SRB Summary Report

2. Once you have selected a plan and a report, click on the View Reports link.
3. The SRB Summary report (Figure 54) displays the SRB multipliers, projected number

of SRB takers and projected cost (in thousands of dollars) by skill, paygrade, and
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zone for the selected plan. Use the vertical scroll bar on the right side of the display
grid or use the PageUp and PageDown keys to see additional rows of the report. Use
the horizontal scroll bar at the bottom of the display grid or the Right and Left Arrow
keys to see additional columns of the report.
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S5 SRB Summaryr Microsoft Excel
the Export to Excel button at the top of the page. The Dialog Box displayed in Figure
55 shows that the workbook is automatically named using the convention
SRBSumm&Planname.XLS (e.g., SRBSummExampleTest.XLS). You may either open
the workbook directly or save the workbook to a local or remote (network drive).

Do you wart to open Or sae tINS file?

Name: SRBSumrmExampleTEiX
Type: Microsoft Excel Vlori~sheet

From: obrien

)Nhi Is files from the Internet can be useful, some Niee can potenrtially
ham our computer. lf you do not trust thie source, do not open or

save thisfile. Vhat~S the fisk7

Figure 55. Export SRB Summary Report to Excel

5. When you save the workbook, you may also choose a different name by overwriting
the default name in the File Name box (see Figure 56).
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Save in: J¸ ¸ ¸ epost
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Filenamne: nv

Save a. type: .i.oso.t E.cel : :krshtet :. :

Figure 56. SRB Summary Report Export Save to Disk

6. Once open in Excel, the SRB Summary Report can be customized or compared to the
SRB Summary Report from another plan (see Figure 57).
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Figure 57. SRB Summary Workbook

7. Click the Home link to return to the main page.

PrImzaryMAOS Re~port

1 Select an SRB Plan from the Plan Name dropdown box to the right of the View
Reports link. Choose the Primary MOS report from the Report Name Dropdown box
(see Figure 58).
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Figure 58. Select Primary MOS Report

2. Once you have selected a plan and a report, click on the View Reports link.
3. The Primary MOS report (Figure 59) displays the SRB multipliers by skill, paygrade,

and zone for the selected plan. The only difference between this report and the SRB
Multipliers report is that this report only includes skills defined by MOS alone (i.e.,
no ASI, SQI, Language, or Location). Use the scroll bar on the right side of the
display grid or use the PageUp and PageDown keys to see additional rows of the
report.
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Figure 59. Primary MOS Report

4. You can export the Primary MOS report to a Microsoft Excel workbook by clicking
the Export to Excel button at the top of the page. The Dialog Box displayed in Figure
60 shows that the workbook is automatically named using the convention
PrimaryMOS&Planname.XLS (e.g., MultExampleTest.XLS). You may either open the
workbook directly or save the workbook to a local or remote (network drive).

Do you w.nt to open or save this file?

[ Name: PrimaryMOSPlan04163.XLS

Type. Mlicosoft Excel Worksheet

From: obrien

While files from the Internet can be useful, some files can potentially

harm your computer. if you do not trust the source, do not open or

save this file. %'hat's the risk?

Figure 60. Export Primary MOS Report to Excel

5. When you save the workbook, you may also choose a different name by overwriting
the default name in the File Name box (see Figure 61).
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Figure 61. Primary MOS Report Export Save to Disk

6. Once open in Excel, the Primary MOS report can be customized or compared to the
Primary MOS report from another plan (see Figure 62).
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Figure 62. Primary MOS Workbook

7. Click the Home link to return to the main page.
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Appendix A: ACOL Coefficients
ACOL Coefficients Unemployment Coefficients

Zone Zone

MOS A B C A B C

OOB 0.000374t 0.000193f 0.000075* 0.0299* 0.0145* 0.0000*

OOD 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

OOE 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

00R 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

OOU 0.000448t 0,000109t 0.000075* 0.0816f 0.0456f 0.0000*

OOZ 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

O1H 0.000458t 0.000154t 0.000079t 0.0299* 0.0724f 0.0000*

02A 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

02B 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

02C 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

02D 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

02E 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

02F 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

02G 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

02H 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

02J 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

02K 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

02L 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

02M 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

02N 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

02S 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

02T 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

02U 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

02Z 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

09B 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

09C 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

09D 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

09R 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

09S 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

09T 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

09W 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

1iB 0.0003871 0.000302f 0.000171t 0.13231 0.0660t 0.0000*

llC 0.000306t 0.000296f 0.000128t 0.0889f 0.1719t 0.0000*

11H 0.000397t 0.000302f 0.000128t 0.0889f 0.0447f 0.0000*

llM 0.000415t 0.000269t 0.000095t 0.0788T 0.0447t 0.0000*

lix 0.000397t 0.000302t 0.000128t 0.0889f 0.0447t 0.0000*

liZ 0.000397t 0.000302t 0.000128t 0.0889t 0.0447f 0.0000*

12B 0.000215t 0.000205f 0.000108t 0.0299* 0.0145* 0.0000*

12C 0.000247t 0.000224t 0.000108f 0.0299* 0.0145* 0.0000*

12F 0.000247t 0.000224f 0.000108t 0.0299* 0.0145* 0.0000*

12Z 0.000247t 0.000224t 0.000108t 0.0299* 0.0145* 0.0000*

13B 0.000589t 0.000260t 0.000076t 0.0299* 0.0145* 0.0000*

13C 0.000399t 0.000254f 0.000076f 0.0299* 0.0145* 0.0000*

13D 0.000399t 0.000254f 0.000076f 0.0299* 0.0145* 0.0000*

13E 0.000399t 0.000254t 0.000076f 0.0299* 0.0145* 0.0000*

13F 0.000399t 0.000254t 0.000076t 0.0299* 0.0145* 0.0000*

13M 0.000399t 0.000254f 0.000076f 0.0299* 0.0145* 0.0000*

13N 0.000399t 0.000254t 0.000076t 0.0299* 0.0145* 0.0000*

13P 0.000399t 0.000254t 0.000076t 0.0299* 0.0145* 0.0000*

13R 0.000399t 0.000254t 0.000076t 0.0299* 0.0145* 0.0000*

13S 0.000399f 0.000254t 0.000076t 0.0299* 0.0145* 0.0000*

13T 0.000399t 0.000254f 0.000076t 0.0299* 0.0145* 0.0000*

13W 0.000399t 0.000254f 0.000076f 0.0299* 0.0145* 0.0000*

13X 0.000399t 0.000254t 0.000076t 0.0299* 0.0145* 0.0000*

13Z 0.000399t 0.000254t 0.000076t 0.0299* 0.0145* 0.0000*

14D 0.000197t 0.000196t 0.000075* 0.0299* 0.0145* 0.0000*

14E 0.000197t 0.000196f 0.000075* 0.0299* 0.0145* 0.0000*

14J 0.000197t 0.000196t 0.000075* 0.0299* 0.0145* 0.0000*
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14L 0.000197t 0.000196t 0.000075* 0.0299* 0.0145* 0.0000*

14M 0.000197t 0.000196t 0.000075* 0.0299* 0.0145* 0.0000*

14R 0.000197t 0.000196t 0.000075* 0.0299* 0.0145* 0.0000*

14S 0.000197t 0.000196t 0.000075* 0.0299* 0.0145* 0.0000'

14T 0.000197t 0.000196t 0.000075* 0.0299* 0.0145* 0.0000*

14Z 0.000197t 0.000196t 0.000075* 0.0299* 0.0145* 0.0000*

15B 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

15D 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

15E 0.000399t 0.000254t 0.000076t 0.0299* 0.0145* 0.0000*

15F 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

15G 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

15H 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

15J 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

15K 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

15M 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

15N 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

15P 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

15Q 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

15R 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

15S 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

15T 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

15U 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

15V 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

15X 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

15Y 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

15Z 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

16D 0.000197t 0.000196t 0.000075* 0.0299* 0.0145* 0.0000*

16E 0.000197f 0.000196t 0.000075* 0.0299* 0.0145* 0.0000*

16F 0.000197t 0.000196t 0.000075* 0.0299* 0.0145* 0.0000*

16J 0.000197f 0.000196t 0.000075* 0.0299* 0.0145* 0.0000*

16P 0.000197t 0.000196t 0.000075* 0.0299* 0.0145* 0.0000*

16R 0.000197t 0.000196t 0.000075* 0.0299* 0.0145* 0.0000*

16S 0.000197t 0.000196t 0.000075* 0.0299* 0.0145* 0.0000*

16T 0.000197t 0.000196t 0.000075* 0.0299* 0.0145* 0.0000*

16X 0.000197t 0.000196t 0.000075* 0.0299* 0.0145* 0.0000*

16Z 0.000197f 0.000196t 0.000075* 0.0299* 0.0145* 0.0000*

17B 0.000399t 0.000254t 0.000076t 0.0299* 0.0145* 0.0000*

18B 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

18C 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

18D 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

18E 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

18F 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

18X 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

18Z 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

19D 0.000678f 0.000230f 0.000124t 0.1855t 0.0145* 0.0000*

19E 0.000510t 0.000253t 0.000129t 0.1065f 0.0145* 0.0000*

19K 0.000419t 0.000292f 0.000093T 0.0748f 0.0145* 0.0000*

19Z 0.000510t 0.000253t 0.000129t 0.1065t 0.0145* 0.0000*

21B 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

21C 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

21D 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

21E 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

21F 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

21G 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

21H 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

21J 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

21K 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

21L 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

21M 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
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21N 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

21P 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

21Q 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

21R 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

21S 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

21T 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

21U 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

21V 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

21W 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

21X 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

21Y 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

21Z 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

23R 0.000197f 0.000196t 0.000075* 0.0299* 0.0145* 0.0000*

24C 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

24G 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

24H 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

24K 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

24M 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

24N 0.000197f 0.000196t 0.000075* 0.0299* 0.0145* 0.0000*

24R 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

24T 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

25B 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

25C 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

25D 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

25F 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

25L 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

25M 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

25P 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

25Q 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

25R 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

25S 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

25T 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

25U 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

25V 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

25W 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

25X 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

25Y 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

25Z 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

27B 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

27D 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

27E 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

27F 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

27G 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

27H 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

27J 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

27K 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

27L 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

27M 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

27N 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

27T 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

27V 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

27X 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

27Z 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

29E 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

29F 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

29J 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

29M 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

29N 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

29P 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
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29S 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
29T 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
29V 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
29W 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
29X 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
29Y 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
29Z 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
31B 0.000305t 0.000183t 0.000088t 0.0406t 0.0145* 0.0000*
31C 0.000305t 0.000183t 0.000088t 0.0406t 0.0145* 0.0000*
31D 0.000305t 0.000183t 0.000088t 0.0406t 0.0145* 0.0000*
31E 0.000305t 0.000183t 0.000088t 0.0406t 0.0145* 0.0000*
31F 0.000305t 0.000183t 0.000088t 0.0406t 0.0145* 0.0000*
31G 0.000305t 0.000183t 0.000088t 0.0406t 0.0145* 0.0000*
31K 0.000305t 0.000183t 0.000088t 0.0406t 0.0145* 0.0000*
31L 0.000305t 0.000183t 0.000088t 0.0406t 0.0145* 0.0000*
31M 0.000305t 0.000183t 0.000088t 0.0406t 0.0145* 0.0000*
31N 0.000305t 0.000183t 0.000088t 0.0406t 0.0145* 0.0000*
31P 0.000305t 0.000183t 0.000088t 0.0406t 0.0145* 0.0000*
31Q 0.000305t 0.000183t 0.000088t 0.0406t 0.0145* 0.0000*
31R 0.000305t 0.000183t 0.000088t 0.0406t 0.0145* 0.0000*
31S 0.000305t 0.000183t 0.000088t 0.0406t 0.0145* 0.0000*
31T 0.000305t 0.000183t 0.000088f 0.0406t 0.0145* 0.0000*
31U 0.000274T 0.000209T 0.000160f 0.2506t 0.37011 0.0000*
31V 0.000305t 0.000183t 0.000088t 0.0406f 0.0145* 0.0000*
31W 0.000305t 0.000183t 0.000088t 0.0406t 0.0145* 0.0000*
31Y 0.000305t 0.000183t 0.000088t 0.0406t 0.0145* 0.0000*
31Z 0.000305t 0.0001831 0.000088t 0.0406t 0.0145* 0.0000*
33M 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
33P 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
33Q 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
33R 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
33T 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
33V 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
33W 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
33Y 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
33Z 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
35A 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
35B 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
35C 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
35D 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000"
35E 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
35F 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
35G 0.000458t 0.000154t 0.000079t 0.0299* 0.0724t 0.0000*
35H 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
35J 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
35K 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
35L 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
35M 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
35N 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
35P 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
35Q 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
35R 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
35S 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
35T 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
35U 0.000458t 0.000154t 0.000079t 0.0299* 0.0724t 0.0000*
35V 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
35W 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
35Y 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
35Z 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
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36L 0.000305t 0.000183t 0.000088t 0.0406t 0.0145* 0.0000*
36M 0.000305t 0.000183t 0.000088t 0.0406t 0.0145* 0.0000"
37F 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
38A 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
39B 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
39C 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
39D 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
39E 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
39G 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
39L 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
39V 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
39W 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
39X 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
39Y 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
41C 0.000270t 0.000172t 0.000053t 0.0299* 0.0145* 0.0000*
42A 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
42C 0.000458t 0.000154t 0.000079t 0.0299* 0.0724t 0.0000*
42D 0.000458t 0.000154t 0.0000791 0.0299* 0.0724t 0.0000*
42E 0.000458t 0.000154t 0.000079t 0.0299* 0.0724t 0.0000*
42F 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
42L 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
42R 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
42S 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
43E 0.000178t 0.000178t 0.000075* 0.2554t 0.1065t 0.0000*
43M 0.000178t 0.000178t 0.000075* 0.2554t 0.1065t 0.0000*
44B 0.000270t 0.000172t 0.000053t 0.0299* 0.0145* 0.0000*
44C 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
44E 0.000270t 0.000172t 0.000053t 0.0299* 0.0145* 0.0000*
45B 0.000270t 0.000172t 0.000053t 0.0299* 0.0145* 0.0000*
45D 0.000270t 0.000172t 0.000053t 0.0299* 0.0145* 0.0000*
45E 0.000270t 0.000172t 0.000053t 0.0299* 0.0145* 0.0000*
45G 0.000270t 0.000172t 0.000053t 0.0299* 0.0145* 0.0000*
45K 0.000270t 0.000172t 0.000053t 0.0299* 0.0145* 0.0000*
45L 0.000270t 0.000172t 0.000053t 0.0299* 0.0145* 0.0000*
45N 0.000270t 0.000172t 0.000053t 0.0299* 0.0145* 0.0000*
45T 0.000270t 0.000172t 0.000053t 0.0299* 0.0145* 0.0000*
45Z 0.000270t 0.000172t 0.000053t 0.0299* 0.0145* 0.0000*
46N 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
46Q 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
46R 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
46Z 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
51B 0.000374t 0.000193t 0.000075* 0.0299* 0.0145* 0.0000*
51G 0.000374t 0.000193t 0.000075* 0.0299* 0.0145* 0.0000*
51H 0.000374t 0.000193t 0.000075* 0.0299* 0.0145* 0.0000*
51K 0.000374t 0.000193t 0.000075* 0.0299* 0.0145* 0.0000*
51M 0.000374t 0.000193t 0.000075* 0.0299* 0.0145* 0.0000*
51R 0.000374t 0.000193t 0.000075* 0.0299* 0.0145* 0.0000*
51T 0.000374t 0.000193t 0.000075* 0.0299* 0.0145* 0.0000*
51Z 0.000374t 0.000193t 0.000075* 0.0299* 0.0145* 0.0000*
52C 0.000270t 0.000172t 0.000053t 0.0299* 0.0145* 0.0000*
52D 0.000260t 0.000124f 0.000053t 0.0299* 0.0145* 0.0000*
52E 0.000374t 0.000193t 0.000075* 0.0299* 0.0145* 0.0000*
52F 0.000270t 0.000172t 0.000053t 0.0299* 0.0145* 0.0000*
52G 0.000374t 0.000193t 0.000075* 0.0299* 0.0145* 0.0000*
52X 0.000270t 0.000172t 0.000053t 0.0299* 0.0145* 0.0000*
54B 0.000364t 0.000222t 0.000075* 0.0299* 0.0145* 0.0000*
55B 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
55D 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
55G 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
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55R 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
55X 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
55Z 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
56M 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
57E 0.000178t 0.000178t 0.000075* 0.2554t 0.1065t 0.0000*
57F 0.000178t 0.000178t 0.000075* 0.2554t 0.1065t 0.0000*
62B 0.000270t 0.000172t 0.000053t 0.0299* 0.0145* 0.0000*
62E 0.000374t 0.000193t 0.000075* 0.0299* 0.0145* 0.0000*
62F 0.000374t 0.000193t 0.000075* 0.0299* 0.0145* 0.0000*
62G 0.000374t 0.000193t 0.000075* 0.0299* 0.0145* 0.0000*
62H 0.000374t 0.000193t 0.000075* 0.0299* 0.0145* 0.0000*
62J 0.0003741 0.0001931 0.000075* 0.0299* 0.0145* 0.0000*
62N 0.000374t 0.0001931 0.000075* 0.0299* 0.0145* 0.0000*
63A 0.000270t 0.000172t 0.000053t 0.0299* 0.0145* 0.0000*
63B 0.000195t 0.000189f 0.000053t 0.0299* 0.0145* 0.0000*
63D 0.000270t 0.000172t 0.000053t 0.0299* 0.0145* 0.0000*
63E 0.000270t 0.000172t 0.000053t 0.0299* 0.0145* 0.0000*
63G 0.000270t 0.0001721 0.000053t 0.0299* 0.0145* 0.0000*
63H 0.000270t 0.000172t 0.000053t 0.0299* 0.0145* 0.0000*
63J 0.000270t 0.000172f 0.000053t 0.0299* 0.0145* 0.0000*
63M 0.000270t 0.000172t 0.000053t 0.0299* 0.0145* 0.0000*
63N 0.000270t 0.000172t 0.000053t 0.0299* 0.0145* 0.0000*
63S 0.000270t 0.000172t 0.000053t 0.0299* 0.0145* 0.0000*
63T 0.000270t 0.000172t 0.000053t 0.0299* 0.0145* 0.0000*
63W 0.000270t 0.000172t 0.000053t 0.0299* 0.0145* 0.0000*
63X 0.000270t 0.000172t 0.000053t 0.0299* 0.0145* 0.0000*
63Y 0.000270t 0.000172t 0.000053t 0.0299* 0.0145* 0.0000*
63Z 0.000270t 0.000172t 0.000053t 0.0299* 0.0145* 0.0000*
67B 0.000387t 0.000321t 0.000104t 0.0299* 0.3127t 0.0000*
67G 0.000387t 0.000321t 0.000104t 0.0299* 0.3127t 0.0000*
67H 0.000387t 0.000321t 0.000104t 0.0299* 0.3127t 0.0000*
67N 0.000387t 0.000321t 0.000104t 0.0299* 0.3127t 0.0000*
67R 0.000387t 0.000321t 0.000104t 0.0299* 0.3127t 0.0000*
67S 0.000387t 0.000321t 0.000104t 0.0299* 0.3127t 0.0000*
67T 0.000387t 0.000321t 0.000104t 0.0299* 0.31271 0.0000*
67U 0.000387t 0.000321t 0.000104t 0.0299* 0.3127t 0.0000*
67V 0.000387t 0.000321t 0.000104t 0.0299* 0.3127t 0.0000*
67X 0.000387t 0.000321t 0.000104t 0.0299* 0.3127t 0.0000*
67Y 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
67Z 0.000387t 0.000321t 0.000104t 0.0299* 0.3127t 0.0000*
68B 0.000387t 0.000321t 0.000104t 0.0299* 0.3127t 0.0000*
68D 0.000387t 0.000321t 0.000104t 0.0299* 0.3127t 0.0000*
68F 0.000387t 0.000321t 0.000104t 0.0299* 0.3127t 0.0000*
68G 0.000387t 0.000321t 0.0001041 0.0299* 0.3127t 0.0000*
68H 0.000387t 0.000321t 0.000104t 0.0299* 0.3127t 0.0000*
68J 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
68K 0.000387t 0.000321t 0.000104t 0.0299* 0.3127t 0.0000*
68L 0.000387t 0.000321t 0.000104t 0.0299* 0.3127t 0.0000*
68N 0.000387t 0.000321t 0.000104t 0.0299* 0.3127t 0.0000*
68P 0.000387t 0.000321t 0.000104t 0.0299* 0.3127t 0.0000*
68Q 0.000387t 0.000321t 0.000104t 0.0299* 0.3127t 0.0000*
68R 0.000387t 0.000321t 0.000104t 0.0299* 0.3127t 0.0000*
68S 0.000387t 0.000321t 0.000104t 0.0299* 0.3127t 0.0000*
68X 0.000387t 0.000321t 0.000104t 0.0299* 0.3127t 0.0000*
68Y 0.000387t 0.000321t 0.000104t 0.0299* 0.3127t 0.0000*
71C 0.000448t 0.000109t 0.000075* 0.0816t 0.0456t 0.0000*
71D 0.000448t 0.000109t 0.000075* 0.0816t 0.0456t 0.0000*
71E 0.000448t 0.0001099 0.000075* 0.0816t 0.0456t 0.0000*
71G 0.000458t 0.000154t 0.000079t 0.0299* 0.0724t 0.0000*
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71L 0.000463t 0.000090t 0.000075* 0.2033t 0.1029t 0.0000*

71M 0.000448f 0.000109t 0.000075* 0.0816t 0.0456t 0.0000*

72E 0.000305t 0.000183t 0.000088t 0.0406t 0.0145* 0.0000"

72G 0.000305f 0.000183t 0.000088t 0.0406t 0.0145* 0.0000*

73C 0.000448t 0.000109t 0.000075* 0.0816t 0.0456t 0.0000*

73D 0.000448t 0.000109t 0.000075* 0.0816t 0.0456t 0.0000*

73Z 0.000448t 0.000109t 0.000075* 0.0816t 0.0456t 0.0000*

74B 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

74C 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

74D 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

74F 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

74G 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

74Z 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

75B 0.000448t 0.000109t 0.000075* 0.0816t 0.0456t 0.0000*

75C 0.000448t 0.000109t 0.000075* 0.0816t 0.0456t 0.0000*

75D 0.000448t 0.000109t 0.000075* 0.0816t 0.0456t 0.0000*

75E 0.000448t 0.000109t 0.000075* 0.0816t 0.0456t 0.0000*

75F 0.000448t 0.000109t 0.000075* 0.0816t 0.0456t 0.0000*

75H 0.000448t 0.000109t 0.000075* 0.0816t 0.0456t 0.0000*

75Z 0.000448t 0.000109t 0.000075* 0.0816t 0.0456t 0.0000*

76C 0.000644t 0.000277t 0.000075* 0.1621t 0.0145* 0.0000*

76J 0.000458t 0.000154t 0.000079t 0.0299* 0.0724t 0.0000*

76P 0.000644t 0.000277t 0.000075* 0.1621t 0.0145* 0.0000*

76V 0.000644t 0.000277t 0.000075* 0.1621t 0.0145* 0.0000*

76X 0.000644t 0.000277t 0.000075* 0.1621t 0.0145* 0.0000*

76Y 0.000679t 0.000327t 0.000075* 0.1450T 0.0145* 0.0000*

76Z 0.000644t 0.000277t 0.000075* 0.1621t 0.0145* 0.0000*

77F 0.000108t 0.000240t 0.000075* 0.0299* 0.0145* 0.0000*

77L 0.000124t 0.000243t 0.000075* 0.0299* 0.0145* 0.0000*

77W 0.000124t 0.000243t 0.000075* 0.0299* 0.0145* 0.0000*

79D 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

79R 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

79S 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

79T 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

79V 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

81B 0.000374t 0.000193t 0.000075* 0.0299* 0.0145* 0.0000*

81C 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

81L 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

81Q 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

81T 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

81Z 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

82B 0.000374t 0.000193t 0.000075* 0.0299* 0.0145* 0.0000*

82C 0.000399t 0.000254t 0.000076t 0.0299* 0.0145* 0.0000*

82D 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

83E 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

83F 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*

88H 0.000239t 0.000196t 0.000075* 0.0299* 0.0145* 0.0000*

88K 0.000239t 0.000196t 0.000075* 0.0299* 0.0145* 0.0000*

88L 0.000239f 0.000196t 0.000075* 0.0299* 0.0145* 0.0000*

88M 0.000240t 0.000201T 0.000075* 0.0299* 0.0145* 0.0000*

88N 0.000239t 0.000196t 0.000075* 0.0299* 0.0145* 0.0000*

88P 0.000239t 0.000196t 0.000075* 0.0299* 0.0145* 0.0000*

88Q 0.000239t 0.000196t 0.000075* 0.0299* 0.0145* 0.0000*

88R 0.000239t 0.000196t 0.000075* 0.0299* 0.0145* 0.0000*

88S 0.000239t 0.000196t 0.000075* 0.0299* 0.0145* 0.0000*

88T 0.000239t 0.000196t 0.000075* 0.0299* 0.0145* 0.0000*

88U 0.000239t 0.000196t 0.000075* 0.0299* 0.0145* 0.0000*

88V 0.000239t 0.000196t 0.000075* 0.0299* 0.0145* 0.0000*

88W 0.000239t 0.000196f 0.000075* 0.0299* 0.0145* 0.0000*
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88X 0.000239t 0.000196t 0.000075* 0.0299* 0.0145* 0.0000*
88Y 0.000239t 0.000196t 0.000075* 0.0299* 0.0145* 0.0000*
88Z 0.000239t 0.000196t 0.000075* 0.0299* 0.0145* 0.0000*
89B 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
89D 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
91A 0.000458t 0.000154t 0.000079t 0.0299* 0.0724t 0.0000*
91B 0.000323f 0.000018t 0.000079t 0.0299* 0.0724t 0.0000*
91C 0.0004581 0.000154t 0.000079t 0.0299* 0.0724t 0.0000*
91D 0.000458t 0.000154t 0.000079t 0.0299* 0.0724t 0.0000*
91E 0.000458t 0.000154t 0.000079t 0.0299* 0.0724t 0.0000*
91F 0.0004581 0.000154t 0.000079t 0.0299* 0.0724t 0.0000*
91G 0.000458t 0.000154t 0.000079t 0.0299* 0.0724t 0.0000*
91H 0.000458t 0.000154t 0.000079t 0.0299* 0.0724t 0.0000*
911 0.0004581 0.0001541 0.0000791 0.0299* 0.0724t 0.0000*
91K 0.000458t 0.000154t 0.000079t 0.0299* 0.0724t 0.0000*
91L 0.000458t 0.000154t 0.000079t 0.0299* 0.0724t 0.0000*
91M 0.000458t 0.000154t 0.000079t 0.0299* 0.0724t 0.0000*
91N 0.000458t 0.000154t 0.000079t 0.0299* 0.0724t 0.0000*
91P 0.000458t 0.000154t 0.000079t 0.0299* 0.0724t 0.0000*
91Q 0.000458t 0.000154t 0.000079t 0.0299* 0.0724t 0.0000*
91R 0.000458t 0.000154t 0.000079t 0.0299* 0.0724t 0.0000*
91S 0.000458t 0.000154t 0.000079t 0.0299* 0.0724t 0.0000*
91T 0.0004581 0.000154t 0.000079t 0.0299* 0.0724t 0.0000*
91U 0.000458t 0.000154t 0.000079t 0.0299* 0.0724t 0.0000*
91V 0.000458t 0.000154t 0.000079t 0.0299* 0.0724t 0.0000*
91W 0.0004581 0.0001541 0.000079t 0.0299* 0.0724t 0.0000*
91X 0.000458t 0.000154t 0.000079t 0.0299* 0.0724t 0.0000*
91Y 0.000458t 0.000154t 0.000079t 0.0299* 0.0724t 0.0000*
91Z 0.000458t 0.0001541 0.000079t 0.0299* 0.0724t 0.0000*
92A 0.000198t 0.0002291 0.000075* 0.3552t 0.1065t 0.0000*
92B 0.000458t 0.0001541 0.000079t 0.0299* 0.0724t 0.0000*
92E 0.0004581 0.0001541 0.000079t 0.0299* 0.0724t 0.0000*
92F 0.000178t 0.0001781 0.000075* 0.25541 0.1065t 0.0000*
92G 0.000178t 0.0001781 0.000075* 0.2554t 0.1065t 0.0000*
92L 0.000178t 0.000178t 0.000075* 0.2554t 0.1065t 0.0000*
92M 0.000178t 0.000178t 0.000075* 0.2554f 0.1065t 0.0000*
92R 0.000178t 0.0001781 0.000075* 0.2554t 0.1065t 0.0000*
92S 0.000178t 0.0001781 0.000075* 0.2554f 0.1065t 0.0000*
92W 0.000178t 0.000178t 0.000075* 0.2554t 0.1065t 0.0000*
92Y 0.000178t 0.0002301 0.000158t 0.2554t 0.2732t 0.3388t
92Z 0.000178t 0.0001781 0.000075* 0.2554f 0.1065t 0.0000*
93B 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
93C 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
93D 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
93F 0.000399t 0.000254t 0.000076t 0.0299* 0.0145* 0.0000*
93P 0.000361* 0.000209* 0.000075* 0.0299* 0.0145* 0.0000*
94A 0.000688t 0.000258t 0.000186t 0.1439t 0.0145* 0.0000*
94B 0.0006971 0.0002611 0.000185f 0. 1482T 0.0145* 0.0000*
94D 0.000688t 0.000258t 0.000186t 0.1439t 0.0145* 0.0000*
94E 0.000688t 0.000258t 0.000186t 0.1439t 0.0145* 0.0000*
94F 0.000688t 0.000258t 0.000186t 0.1439t 0.0145* 0.0000*
94H 0.000688t 0.000258t 0.000186t 0.1439t 0.0145* 0.0000*
94K 0.000688t 0.000258t 0.000186t 0.14391 0.0145* 0.0000*
94L 0.000688t 0.000258t 0.000186t 0.1439t 0.0145* 0.0000*
94M 0.000688t 0.000258t 0.000186t 0.1439t 0.0145* 0.0000*
94P 0.000688t 0.000258t 0.000186t 0.1439t 0.0145* 0.0000*
94R 0.000688t 0.000258t 0.000186t 0.1439t 0.0145* 0.0000*
94S 0.000688t 0.000258t 0.000186t 0.1439t 0.0145* 0.0000*
94T 0.0006881 0.000258t 0.000186t 0.1439t 0.0145* 0.0000*
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94V 0.000688t 0.000258t 0.000186t 0.1439t 0.0145* 0.0000*
94W 0.000688t 0.000258t 0.000186f 0.1439t 0.0145* 0.0000*
94Y 0.000688t 0.000258t 0.000186t 0.1439t 0.0145* 0.0000*
94Z 0.000688t 0.000258t 0.000186t 0.1439t 0.0145* 0.0000*
95B 0.000253f 0.000196t 0.000108t 0.0299* 0.2229t 0.0000*
95C 0.000291t 0.000206t 0.000136t 0.0299* 0.2140t 0.0000*
95D 0.000291f 0.000206t 0.000136t 0.0299* 0.2140t 0.0000*
96B 0.000170t 0.000161t 0.000203t 0.0299* 0.1316t 0.0000*
96D 0.000170t 0.000161t 0.000203t 0.0299* 0.1316t 0.0000*
96F 0.000170t 0.000161t 0.000203t 0.0299* 0.1316t 0.0000*
96H 0.0001701 0.000161t 0.000203t 0.0299* 0.1316t 0.0000*
96R 0.000170t 0.000161t 0.000203t 0.0299* 0.1316t 0.0000*
96U 0.000170t 0.000161t 0.000203t 0.0299* 0.1316t 0.0000*
96Z 0.0001701 0.000161t 0.000203t 0.0299* 0.1316t 0.0000*
97B 0.000170t 0.000161t 0.000203t 0.0299* 0.1316t 0.0000*
97E 0.000170t 0.000161t 0.000203t 0.0299* 0.1316t 0.0000*
97G 0.000170t 0.000161t 0.000203t 0.0299* 0.1316t 0.0000*
97L 0.000170f 0.000161t 0.000203t 0.0299* 0.1316t 0.0000*
97Z 0.000170t 0.000161t 0.000203t 0.0299* 0.1316t 0.0000*
98C 0.000270t 0.000153t 0.000177t 0.1546t 0.0145* 0.0000*
98D 0.000270t 0.000153t 0.000177t 0.1546t 0.0145* 0.0000*
98G 0.000270t 0.000153t 0.000177t 0.1546t 0.0145* 0.0000*
98H 0.000270f 0.000153t 0.000177t 0.1546t 0.0145* 0.0000*
98J 0.000270t 0.000153t 0.000177t 0.1546t 0.0145* 0.0000*
98K 0.000270t 0.000153t 0.000177t 0.1546t 0.0145* 0.0000*
98P 0.000270t 0.000153f 0.000177t 0.1546t 0.0145* 0.0000*
98X 0.000270t 0.000153t 0.000177t 0.1546t 0.0145* 0.0000*
98Y 0.000270t 0.000153t 0.000177t 0.1546t 0.0145* 0.0000*
98Z 0.000270t 0.000153t 0.000177t 0.1546t 0.0145* 0.0000*

* = Coefficient based on all-Army model

t = Coefficient based on CMF-specific model
t= Coefficient based on MOS-specific model
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